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Capabilities

Whisper Announcement plays a brief, prerecorded message to an agent just before the agent connects with
each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ring tone
patterns) while the announcement plays.

The content of the announcement can contain information about the caller that helps prepare the agent to
handle the call. The information can include caller language preference, choices the caller made from a menu
(Sales, Service), customer status (Platinum, Gold, Regular), and so on.

After Whisper Announcement is enabled, the played announcements are specified in the call routing scripts.
The determination of which announcement to play is controlled in the script and is based on various inputs,

such as the dialed number, a customer ID look up in your customer database, or selections you made from a
VRU menu.

Functional Limitations

Whisper Announcement is subject to these limitations:

» Announcements do not play for outbound calls made by an agent. The announcement plays for inbound
calls only.

» For Whisper Announcement to work with agent-to-agent calls, use the SendToVRU or
TranslationRouteToVRU node before you transfer the call to the agent. Transfer the call to Unified CVP
before you transfer the call to another agent. Then, Unified CVP can control the call and play the
announcement, regardless of which node transfers the call to Unified CVP.

» Announcements do not play when the router selects the agent through a label node.
» CVP Refer Transfers do not support Whisper Announcement.

* Whisper Announcement supports Silent Monitoring with this exception: For Unified Communications
Manager-based Silent Monitoring, supervisors cannot hear the announcements themselves. The supervisor
desktop dims the Silent Monitor button while an announcement plays.
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* Only one announcement can play for each call. While an announcement plays, you cannot put the call
on hold, transfer, or conference; release the call; or request supervisor assistance. These features become
available again after the announcement completes.

* The codec settings for Whisper Announcement recording and the agent's phone must match. For example,
if Whisper Announcement is recorded in G.711 ALAW, the phone must also be at G.711 ALAW. If
Whisper Announcement is recorded in G.729, the phone must support or connect using G.729.

* Forking happens in Gateway in NBR only when a caller is connected to the agent (with two-way audio).
Whisper announcement is played only with one way audio with agent (before connecting to the caller).

* In an IPv6-enabled environment, Whisper Announcement might require extra Media Termination Points
(MTPs).

Deployment Tasks

The following list shows the high-level tasks that are required to deploy Whisper Announcement. Individual
steps are covered in more detail in later sections.

1. Ensure your deployment meets the baseline requirements for software, hardware, and configuration
described in the System Requirements and Limitations section. See the Solution Design Guide for Cisco
Unified Contact Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-implementation-design-guides-list.html.

Create Whisper Announcement Audio Files, on page 2.
Deploy Whisper Announcement Audio Files to Media Server, on page 3.

2

3

4. Configure Whisper Service Dialed Numbers, on page 3.

5. Add Whisper Announcement to Routing Scripts, on page 5.
6

Fail-Safe Timeout for Whisper Announcement in Unified CCE, on page 7.

Example scripts that enable Whisper Announcement are installed with your system. For information about
these scripts and how to access them, see Whisper Announcement Sample Scripts, on page 8.

Create Whisper Announcement Audio Files

You must create audio files for each different Whisper Announcement you want to use on your system; for
example, “Sales, English” or “Soporte Técnico en Espafiol.” Create the files using the recording tool of your
choice.

When recording your files, follow these rules:

* The media files must be in wave (.wav) format. Your wave files must match Unified CVP encoding and
format requirements (G729, CCITT G.711 A-Law and U-law 8 kHz, 8 bit, mono).

* To avoid cutting off files when they are played, make sure they do not exceed the Whisper Announcement
play limit (15 seconds).

* Test your audio files. Ensure that they are not cut off and that they are consistent in volume and tone.
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* To reduce the likelihood of scripting errors, decide ahead of time on a file-naming convention that is
easy for you and others to remember. For example, en_sales.wav, sp_support.wav.

Deploy Whisper Announcement Audio Files to Media Server

Deploy your whisper audio files to your Unified CVP media server using whatever file-transfer method you
prefer. The most important consideration is where on the server to place the files. HTTP requests for media
server audio files are constructed as

http://<media server>/<locale directory>/<application directory>/<file name>.

The CVP defaults for the locale and application directories are en-us/app. Unified CCE automatically
adds en-us/app to the server name when making HTTP requests for media files.

For example, if:

* The script node that defines the media server has a value of http://myserver.mydomain.com
and

* The script node that defines the audio file to play has a value of en _sales.wav

Then the HTTP request for the file is automatically constructed as

http://myserver.mydomain.com/en-us/app/en_sales.wav

If you store your files in a different locale and application directory, your routing scripts must include variable
nodes that define those alternate locations. Make note of the directories in which you place your files and
communicate the locations to your script authors.

Make sure that the directories in which you deploy your files have the appropriate permissions to allow Read
access.

CVP with the Streaming Audio (Helix) and Whisper Announcement

You must set the user.microapp.media_server variable, to point to the whisper announcement .wav file, for
the CVP Whisper Announcement feature to work while Streaming Audio feature (using Helix) is also on.
This is achieved by setting the Call.Whisper Announcement variable to the complete URL of the whisper
announcement wav file. The Call.Whisper Announcement variable should be put in using the
http://<VXMLserverip>:7000/CVP/audio/XXX.wav URL format.

Using a Default Media Server

Optionally, CVP lets you define a default media server. (You do this in the CVP Operations Console; see
your CVP documentation for more information.) If a default media server is defined in CVP, script authors
need not identify the media server in their call routing scripts provided the files that they request are available
from that server.

Configure Whisper Service Dialed Numbers

For Whisper Announcement, Unified CVP uses two different dialed numbers when transferring a call to an
agent:

* The first number calls the ringtone service that the caller hears while the whisper plays to the agent. The
CVP default for this number is 91919191.

* The second number calls the whisper itself. The Unified CVP default for this number is 9191919100.
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\}

Note Whisper Announcement dialed number is always an extension of the Ringtone
dialed number with an extra two zeros at the end.

For Whisper Announcement to work, your dial plan must include both of these numbers. The easiest way to
ensure coverage is through the use of wild cards such as 9191*.

Configure Dialed Numbers

You configure the dialed numbers for Whisper Announcement in the Unified CVP Operations Console at
System > Dialed Number Pattern > Add new. For the Dialed Number Pattern Types, select Enable L ocal
Static Route. Once Enable Local Static Route is checked, select either Route to Device or Routeto SIP
Server Group for VXML gateways. Then save and deploy the dialed number.

It may be necessary to override the dialed number plan for the default Whisper DN, if the default DN conflicts
with the overall dial number plan.

Change the Whisper Announcement Default Dialed Number

Step 1
Step 2
Step 3
Step 4
Step 5

To override the DN pattern from the SIP subsystem level in CVP OAMP:

Procedure

Select Device Management > Unified CVP Server.

Select the Call Server on which to override the default whisper DN.

Select the SIP tab.

Override the default value 0f 91919191 configured under the DN on the Gateway to play theringtone field.
Click Save & Deploy.

Configure Ringtone Dialed Number

To configure the Ringtone dialed number in the CVP Operations Console:

1. Select Device Management > Unified CVP Server.

2. Select the Call Server on which you want to configure the settings.
3. Select the SIP tab.
4

In the DN on the Gateway to play theringtone field, configure the default Ringtone dialed number
Pattern.

Dialed Number in the Dial-Peer

In addition to configuring the dial plan in Unified CVP, examine your IOS dial-peer. Make sure that the dialed
number setting in your dial-peer configuration accommodates both of the whisper service dialed numbers.
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Add Whisper Announcement to Routing Scripts

To enable Whisper Announcements, use the Script Editor to modify your routing scripts as follows:
* Specify the WhisperAnnouncement call variable
* Specify the Unified CVP media server and location of whisper audio files

* Specify other required variables

For more information, see Whisper Announcement Sample Scripts, on page 8.

Specify WhisperAnnouncement Call Variable

To include Whisper Announcement in a script, insert a Set Variable node that references the
WhisperAnnouncement call variable. The WhisperAnnouncement variable causes a whisper to play and
specifies the audio file it should use. Typically, you use a single whisper prompt for a single call type. As a
result, you use only one WhisperAnnouncement set node for each script. However, as needed, you can set
the variable at multiple places in your scripts to allow different announcements to play for different endpoints.
For example, for skills-based routing, you can specify the variable at each decision point used to select a
particular skill group or Precision Queue.

\}

Note Only one Whisper Announcement can play for each call. If a script references and sets the
WhisperAnnouncement variable more than once in a single path through a script, the last value to be set is
the one that plays.

Use these settings in the Set Variable node for Whisper Announcement:

* Object Type: Call.

* Variable: Must use the WhisperAnnouncement variable.

* Value: Specify the filename of the whisper file. For example: “my_whisper.wav” or “my_whisper”.
* Specify the filename only, not its path.
* You must enclose the filename in quotation marks.
* The filename is not case sensitive.
* The filename cannot include spaces or characters that require URL encoding.

* The .wav extension is optional. If you omit it, Unified CVP adds it automatically in the HTTP
request.

Specify Unified CVP Media Server Information

If you define a default media server in your CVP Operations Console and it is the server from which you
serve your whisper files, then you need not specify the media server in your routing scripts. However, if you
do not define a default media server, or if you store your whisper file on a server other than the default, then
your scripts must include a Set Variable node that identifies that server.

To specify your media server, use the following settings in the Set Variable node:
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* Object Type: Call.
* Variable: Must use the user.microapp.media_server ECC variable.

* Value: Specify the HTTP path to the server. For example: “http://myserver.mydomain.net.” You must
enclose the path in quotes.

* Alternately you can specify an IP address in place of a DNS. Include the listening port number if the
media server web server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).

Specify Whisper File Locale and Application Directories

CVP uses a default storage directory for media files: <web server root>/en-us/app. To take advantage of
this, Unified CCE call routing scripts automatically add “en-us/app,” to the server name when constructing
HTTP requests for media files. For example:

* [f the script node that defines the media server has a value of “http://myserver.mydomain.com” and...
* The script node that defines which audio file to play has a value of “en_sales.wav,” then...

* The HTTP request for the file is automatically constructed as

http://myserver.mydomain.com/en-us/app/en_sales.wav
If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your
script that identifies the locale directory. Similarly, if your whisper files are stored in a different application
directory, you must add a Set Variable node that identifies that directory.
Specify Locale Directory
Use these settings in the Set Variable node to specify your locale directory:
* Object Type: Call.

* Variable: Must use the user.microapp.locale ECC variable.

* Value: Specify the directory name. For example: “pt-br,” You must enclose the path in quotes.

Specify Application Directory
Use these settings in the Set Variable node to specify your application directory:
* Object Type: Call.
* Variable: Must use the user.microapp.app_media_lib ECC variable.

* Value: Specify the directory name. For example: to use a directory “wav_files” in place of the default
directory “app,” enter “wav_files.” To use a sub-directory “wav_files” “app,” enter “app/wav_files.”
You must enclose the path in quotes.

Variable Length for Media Server Locale and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the
values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of
“http://mysubdomain.mydomain.co.uk,” the string is 33 characters long. Therefore, the Maximum Length
setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you must increase
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the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and
the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools
> Expanded Call Variables List.

Test Whisper Announcement File Path

To test the path to the whisper file that you defined in you script variables, enter the complete URL into a
browser. The .wav file should play. For example:

* If your script includes: default media server + default locale + default application directory + whisper.wav,
then the path is “http://<default media_server>/en-us/app/whisper.wav”

* If your script includes: http://my_server.my_domain.com + default locale + “app/wav_files” +
whisper.wav, then the path is “http://my_server.my domain.com/en-us/app/wav_files/whisper.wav”

Other Script Settings That Are Required for Whisper Announcement
These additional settings are required for Whisper Announcement to work:

* Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target an
agent. These include Queue (to Skill Group or Precision Queue), Queue Agent, Route Select, and Select.
If Target Requery is not enabled, the Whisper Announcement does not play.

* When you run an agent transfer or a conference script, use a SendToVRU, a TranslationToVRU, or a
Run Script Request node before you target an agent.

Fail-Safe Timeout for Whisper Announcement in Unified CCE

Unified CVP sends one message to Unified CCE each time a Whisper Announcement begins and a second
message when the announcement ends. The time stamps from these messages are used to calculate Whisper
Announcement data in Unified CCE reports.

If Unified CVP fails to send a Whisper Announcement end message toUnified CCE, the following occurs:

* Unified CCE cannot accurately calculate the whisper length, thus skewing report data.

* The agent cannot control the call (for example, put it on hold or transfer it) because these controls are
disabled while a Whisper Announcement is playing.

To prevent this, Unified CCE has a Whisper Announcement timeout setting. The value for this setting represents
the maximum Whisper Announcement play time that Unified CCE uses to calculate its report data.

The default is 20 seconds. This default is based on the default Whisper Announcement play time (specified

in Unified CVP) of 15 seconds. The extra 5 seconds in the Unified CCE fail-safe timeout is a buffer against
latency. If you modify the maximum Whisper Announcement play time in Unified CVP, modify the Unified
CCE Whisper Announcement fail-safe timeout accordingly.

The Unified CCE Whisper Announcement fail-safe timeout value should be equal to or greater than the
maximum Whisper Announcement play time setting in Unified CVP. Otherwise, Whisper Announcement
play time in Unified CCE reports are under-reported.

To change the fail-safe timeout value, complete the following steps for theUnified CCE peripheral by using
the PG explorer tool:
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Procedure

Step 1 In Unified CCE Configuration, select Tools> Explorer Tools> PG Explorer.

Step 2 Click Retrieve to return a list of PGs (Peripheral Gateways).

Step 3 Double-click the agent PG to expand it, and select the peripheral with client type CUCM or UCCE system.
Step 4 On the Peripheral tab, enter the following text in the Configuration Parameter s field:

/WHSTMOUT <value in seconds>

Step 5 Once you are finished, click Save.

Whisper Announcement Sample Scripts

Unified CCE includes sample routing scripts that demonstrate Whisper Announcement. You can use them as
learning tools and as models for your own Whisper Announcement scripts. They are the following:

* WA.ICM S—This script plays a Whisper Announcement.

* WA_AG.ICM S—This script plays both a Whisper Announcement and an Agent Greeting to play on
the same call flow.

The script files are located in the c:\icm\bin directory. In Unified CCE Script Editor, they are installed
to the application root directory.

)

Note To use these scripts you must have a default media server configured in Unified CVP, and have the Whisper
file stored in the default location on the media server. For that reason, they do not include variables that specify
the media server, locale, or application directories.

WA.ICMS Script

This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the desired
wave file and then queuing the call to a skill group or Precision Queue. After an agent is selected from the
skill group or Precision Queue and the call routed to the agent, the whisper plays to the agent.
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wA_Ac.Icms Script [J|]

&

This script sets up a whisper
announcment by setting the
whisper announcement variable to
the desired wav file and then gueing
the call to a =kill group. Once an
agent is selected from the skill
group and the call routed to the
agent, the whisper will play to the
agent.

Set the whisper announce
filenarne variable to the desired

& 8
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Release Call
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WA_AG.ICMS Script

This script causes both a Whisper Announcement and an Agent Greeting to play.

This soript vauses both a
whisper announcement and

M REIDE: Send the oallto the VRU

routing elient was not CYF

Set figent Greeting Type,
based oninbound oall pe,
This teatis used 2 part of
the greeting filename. It can
be 3 simple numbering
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filename wariable to the more deseriptive titles such
desired waveile a5 English’

Gueue the eall until agent
becomess available.

Fiun script while agents are
nat available.

=| Set Variable |

) Release Call |

&
Release the call under srror
conditions.

Import Sample Whisper Announcement Scripts

Step 1
Step 2

Queue to Skill Group

L4

kil Group Ho %
CCMPEA_1.Cisco_Waice.5KE1
& []

Release Call

s:f| Run Ext. Seript

To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE
Script Editor. Follow this procedure to import the scripts:

Procedure

Open Script Editor.

Select File>Import Script and select the first of the two scripts to import.

In addition to importing the script, Script Editor tries to map imported objects. Some objects that are referenced
in the sample scripts, such as the external Network VRU scripts or the skill groups or Precision Queues, do
not map successfully. You must create these maps manually or change these references to point to existing
Network VRU scripts, skill groups, and Precision Queues in your system.
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Step 3 Repeat steps 2 and 3 for the remaining script.

How Whisper Announcement Works

Whisper Announcement Audio File

You store and serve your Whisper Announcement audio files from the Cisco Unified Contact Center Enterprise
(Unified CCE) media server. This feature supports only the wave (. wav) file type. The maximum play time
for a Whisper Announcement is subject to a timeout. Playback terminates at the timeout regardless of the
actual length of the audio file. The default timeout is 15 seconds. In practice, you may want your messages
to be much shorter than that, 5 seconds or less, to shorten your call-handling time.

While a Whisper Announcement Is Playing

Only one Whisper Announcement can play for each call. While a Whisper Announcement is playing, you
cannot put the call on hold, transfer, conference, or release the call, or request supervisor assistance. These
features become available again after the whisper is complete.

Whisper Announcement with Transfers and Conference Calls

When an agent transfers or initiates a conference call to another agent, the second agent hears an announcement
if the second agent's number supports Whisper Announcement. In the case of consultative transfers or
conferences, while the whisper plays, the caller hears whatever generally plays during hold. The first agent
hears ringing. In the case of blind transfers, the caller hears ringing while the whisper announcement plays.

Whisper Announcement Call Flow

Following is a Whisper Announcement call flow diagram accompanied by a description of the steps.

. Whisper Announcement
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1. CVP receives a new call from the PSTN.

2 - 3. CVP sends the new call to the VRU PIM and the VRU PIM sends the new call to the Unified CCE
router.

4. If an agent is available, the router reserves the agent.

5 - 6. The router sends a label with a whisper prompt to CVP.
7. CVP sends the call to Unified CM.

8 - 9. The agent receives and answers the call.

10. Unified CM sends the established event to the agent PIM. The agent PIM holds the event until the Whisper
Announcement is done playing.

11. CVP tells the VXML gateway to play ringback to the caller and the Whisper Announcement to the agent.
After the Whisper Announcement plays, CVP connects the agent to the customer and notifies Unified CCE.

12. The agent PIM gets notification that Whisper Announcement is complete and sends the established event
to the agent desktop.

Reporting and Serviceability

Whisper time is not specifically broken out in Unified CCE reports. In agent, skill group, and Precision Queue
reports, the period during which the announcement plays is reported as Reserved agent state time. In the
Termination Call Detail records, it is treated as Ring Time.

Serviceability for Whisper Announcement includes system events to indicate reasons for Whisper
Announcement failures and counters to track the number of failed whisper events.
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Component Failure and Whisper Announcement

Failure to Access CVP Media Server
If the connection to the CVP media server fails, or if a requested whisper audio file cannot be found, the call
proceeds without Whisper Announcement.

Whisper Announcement in Agent Desktop Software

No configuration is needed to integrate Whisper Announcement with agent desktop software. While a whisper
is playing, software on the agent desktop shows the call in the Ring state. Desk phones show the call in the
Talking state.

Using Agent Greeting with Whisper Announcement

You can use Agent Greeting along with the Whisper Announcement feature. Consider the following when
you use them together:

* On the call, the Whisper Announcement always plays first before the greeting.

* To shorten your call-handling time, you may want to use shorter whispers and greetings than you might
if you were using either feature by itself. A long whisper followed by a long greeting means a long wait
before an agent handles a call.

» Usually, agents that use Whisper Announcement handle different types of calls: for example, "English,
Gold Member, Activate Card, Spanish, Gold Member, Report Lost Card, English, Platinum Member,
Account Inquiry." Ensure the greetings your agents record are generic enough to cover the range of
customer calls they handle.
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